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ACRONIS, INC.
End User License Agreement (EULA)
BEFORE INSTALLING AND USING THE SOFTWARE PRODUCT WHICH EITHER YOU HAVE
DOWNLOADED OR IS CONTAINED ON THESE DISKS (“SOFTWARE”) YOU SHOULD CAREFULLY
READ THE FOLLOWING LICENSE AGREEMENT (“AGREEMENT”) THAT APPLIES TO THE
SOFTWARE. CLICK “ACCEPT” IF YOU FULLY ACCEPT AND AGREE TO ALL OF THE PROVISIONS
OF THIS AGREEMENT. OTHERWISE, CLICK “DO NOT ACCEPT.” CLICKING “ACCEPT” OR
OTHERWISE DOWNLOADING, INSTALLING AND OR USING THE SOFTWARE ESTABLISHES A
BINDING AGREEMENT BETWEEN YOU AS THE PERSON LICENSING THE SOFTWARE (THE
"LICENSEE") AND ACRONIS, INC. LOCATED AT: ACRONIS INTERNATIONAL GMBH
VERWALTUNG EURO HAUS RHEINWEG 5 SCHAFFHAUSEN, SWITZERLAND CH-8200,
("LICENSOR"). IF YOU DO NOT ACCEPT ALL OF THE TERMS OF THIS AGREEMENT, YOU SHALL
HAVE NOT RIGHT TO DOWNLOAD, INSTALL AND/OR USE THE SOFTWARE AND MUST DELETE
THE SOFTWARE AND ASSOCIATED FILES IMMEDIATELY.
This Agreement applies to the Software, whether licensed under a Software License and/or an
Evaluation License, each as defined and described below:
Purchased License of Software. Subject to the terms and conditions of this Agreement, upon
purchase of a license to the Software, LICENSOR grants and LICENSEE accepts a nonexclusive,
nontransferable, nonassignable license to use Software only for LICENSEE’s own internal use solely on the
specific number of Hardware (as defined below) licensed owned, leased or otherwise controlled by LICENSEE.
LICENSEE may make one copy of Software only for archival purposes, only in machine readable form, provided
that such archival copy is only used for archival purposes and never in a production environment and is marked
with every notice on the original Installation of Software is LICENSEE’s responsibility. The license described in
this section shall be referred to as a “Software License”).
Evaluation License of Software: The LICENSEE has the right to evaluate the Software for a period
of time not to exceed fifteen (15) days (the “Evaluation Period’) unless extended by LICENSOR. Software
licensed under this Evaluation License may not be used in a production environment. There will be no charge to
the LICENSEE for said evaluation of the Software under this Evaluation License. At the conclusion of the
Evaluation Period, unless a Software License to the Software is purchased, the LICENSEE will delete the
Software from its systems and have no further license or other rights with respect to the Software except as to
the rights and responsibilities in this Agreement. LICENSOR SHALL NOT BE LIABLE FOR ANY SPECIAL,
DIRECT, INDIRECT, PUNITIVE, OR CONSEQUENTIAL DAMAGES RESULTING FROM USE OF SOFTWARE
UNDER THE EVALUATION LICENSE UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR
OTHER THEORY. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL
PURPOSE OF ANY LIMITED REMEDY. The following sections of this Agreement also apply to Evaluation
License(s) of the Software: Limitations, Confidentiality, Disclaimer of Warranties, LICENSEE Indemnity,
Law, Export Restrictions, and Miscellaneous. The license described in this section shall be referred to as an
“Evaluation License”).
Use Rights:
Assigning the License. Before you run any instance of the Software under a Software License, you must
assign that license to one of your PCs or Servers (depending upon the license you have purchased or are
evaluating and such purchase or evaluation is based upon the operating system on which that hardware
operates, such PCs or Servers shall be referred to as the “Hardware”).
That Hardware is the licensed
Hardware for that particular Software license. You may assign other Software Licenses to the same Hardware,
but you may not assign the same Software License to more than one Hardware except as identified herein.
You may reassign a Software License if you retire the licensed Hardware due to permanent Hardware failure. If
you reassign a Software License, the Hardware to which you reassign the license becomes the new licensed
Hardware for that particular Software License.
Running Instances of the Hardware Software. You have the rights to run the Software on one piece of
Hardware as defined above. Every Hardware creating an image and every Hardware to which an image is either
deployed to or restored from must have a valid license. In the case of Universal Deploy or Universal Restore,
every time an image is deployed or restored (as appropriate to either Universal Restore or Universal Deploy), to
Hardware that is dissimilar to the Hardware from which the image was originally created, a valid license of the
Universal Deploy or Universal Restore is required.
You have the rights below for each Software License you assign:
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Standard Software license.
A standard Software License is the general license that is available to
LICENSEE. Unless the Virtual Edition Software is purchased, you have purchased the standard Software
License and may run on the licensed Hardware, at any one time as follows:
•

One (1) instance of the Hardware installed Software in one physical operating system environment; and

•

Up to four (4) instances of the Hardware installed Software in virtual operating system environments
(only one (1) instance per virtual operating system environment).

If you run all five (5) permitted instances at the same time, the instance of the Hardware installed Software
running in the physical operating system environment may be used only to run hardware virtualization
software and to manage and service operating system environments on the licensed Hardware.
Virtual Edition. Virtual Edition (as identified by the product name (for example, True Image Virtual Edition)) is
licensed by physical Hardware. You may run on the licensed Hardware, at any one time as follows:
•

One instance of the Hardware software in one physical operating system environment; and

•

As many instances of the Hardware software in virtual operating system environments.

Support. If LICENSEE is under a current support contract with LICENSOR with respect to the Software and is
current in paying all amounts due thereunder, LICENSOR shall make available to LICENSEE the support
described in this paragraph (the “Support”) on a twenty four (24) hours a day, seven (7) days per week basis.
Support shall consist of: (i) supplying telephone or other electronic support, as determined by LICENSOR in its
sole discretion, to LICENSEE in order to help LICENSEE locate and, on its own, correct problems with the
Software and (ii) supplying all extensions, enhancements and other changes that LICENSOR, at its sole
discretion, makes or adds to the Software and which LICENSOR makes generally available, without additional
charge, to other licensees of the Software that are enrolled in Support. Upon mutual written agreement by both
parties, LICENSOR may, but shall not be required to: (i) supply code corrections to LICENSEE to correct
Software malfunctions in order to bring such Software into substantial conformity with the published operating
specifications for the most current version of the Software unless LICENSEE’s unauthorized modifications
prohibit or hamper such corrections or cause the malfunction; or (ii) supply code corrections to correct
insubstantial problems at the next general release of the Software.

Limitations. Notwithstanding any references to “purchase” , the Software is licensed and not sold pursuant to
this Agreement. This Agreement confers a limited license to the Software and does not constitute a transfer of
title to or sale of all or a portion of the Software, and LICENSOR retains ownership of all copies of the Software.
LICENSEE acknowledges that the Software contain trade secrets of LICENSOR, its suppliers or licensors,
including but not limited to the specific internal design and structure of individual programs and associated
interface information. Accordingly, except as otherwise expressly provided under this Agreement, LICENSEE
shall have no right, and LICENSEE specifically agrees not to: (i) transfer, assign or sublicense its license rights
to any other person or entity, or use the Software on ay equipment other than the Hardware, and LICENSEE
acknowledges that any attempted transfer, assignment, sublicense or use shall be void; (ii) make error
corrections to or otherwise modify or adapt the Software or create derivative works based upon the Software, or
permit third parties to do the same; (iii) reverse engineer or decompile, decrypt, disassemble or otherwise reduce
the Software to human-readable form, except to the extent otherwise expressly permitted under applicable law
notwithstanding this restriction; (iv) use or permit the Software to be used to perform services for third parties,
whether on a service bureau or time sharing basis or otherwise, without the express written authorization of
LICENSEE; or (v) disclose, provide, or otherwise make available trade secrets contained within the Software in
any form to any third party without the prior written consent of LICENSOR.

Confidentiality. The Software is a trade secret of LICENSOR and is proprietary to LICENSOR. LICENSEE
shall maintain Software in confidence and prevent disclosure of Software using at least the same degree of care
it uses for its own similar proprietary information, but in no event less than a reasonable degree of care.
LICENSEE shall not disclose Software or any part thereof to anyone for any purpose, other than to employees
for the purpose of exercising the rights expressly granted under this Agreement. License shall not, and shall not
allow any third party to, decompile, disassemble or otherwise, reverse engineer or attempt to reconstruct or
discover any source code or underlying ideas, algorithms, file formats or programming or interoperability
interfaces of Software or of any files contained or generated using Software by any means whatsoever. The
obligations under this paragraph shall survive any termination of the Agreement.

Disclaimer of Warranties. THE SOFTWARE IS PROVIDED “AS IS” AND LICENSOR DISCLAIMS ALL
WARRANTIES, EXPRESSED OR IMPLIED WITH RESPECT TO SOFTWARE INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY, TITLE, NON-INFRINGEMENT OF THIRD PARTIES’ RIGHTS, AND
FITNESS FOR A PARTICULAR USE. WITHOUT LIMITING THE FOREGOING, LICENSOR DOES NOT
WARRANT THAT THE FUNCTIONS CONTAINED IN SOFTWARE WILL OPERATE IN THE COMBINATION
LICENSEE SELECTS, THAT OPERATION OF SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE
AND/OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. THE ENTIRE RISK AS TO THE
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RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY LICENSEE. FURTHERMORE,
LICENSOR DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE
RESULTS OF THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR
CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. NO ORAL OR WRITTEN
INFORMATION OR ADVICE GIVEN BY LICENSOR SHALL CREATE A WARRANTY OR IN ANY WAY
INCREASE THE SCOPE OF THIS WARRANTY.

Liability Limitations. LICENSOR SHALL NOT BE LIABLE FOR ANY SPECIAL, INDIRECT, PUNITIVE, OR
CONSEQUENTIAL DAMAGES RESULTING FROM USE OF SOFTWARE UNDER ANY CONTRACT,
NEGLIGENCE, STRICT LIABILITY OR OTHER THEORY. LICENSOR’S CUMULATIVE LIABILITY FOR
DAMAGES HEREUNDER, WHETHER IN AN ACTION IN CONTRACT, WARRANTY, TORT, NEGLIGENCE,
STRICT LIABILITY, INDEMNITY, OR OTHERWISE, SHALL IN NO EVENT EXCEED THE AMOUNT OF
LICENSE FEES PAID BY THE LICENSEE FOR THE SOFTWARE LICENSED UNDER THIS AGREEMENT.
THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE OF
ANY LIMITED REMEDY.

LICENSEE Indemnity. LICENSEE agrees to indemnify and defend LICENSOR, and hold it harmless from all
costs, including attorney’s fees, arising from any claim that may be made against LICENSOR by any third party
as a direct or indirect result of any use by LICENSEE of the Software,

Termination. This Agreement and the license may be terminated without fee reduction (i) by LICENSEE
without cause on thirty (30) days notice; (ii) by LICENSOR, in addition to other remedies, if LICENSEE is in
default and fails to cure within ten (10) days following notice; (iii) on notice by either party hereto if the other party
ceases to do business in the normal course, becomes insolvent, or becomes subject to any bankruptcy,
insolvency, or equivalent proceedings. Upon termination for any reason, LICENSEE shall immediately return
Software and all copies to LICENSOR and delete all Software and all copies from the Hardware.

Law. This Agreement shall be governed by the laws of the Commonwealth of Massachusetts, exclusive of its
conflicts of laws provisions and without regard to the United Nations Convention on Contracts for the
International Sale of Goods, and any suit under this Agreement shall exclusively be brought in a federal or state
court in Massachusetts. Any action against LICENSOR under this Agreement must be commenced within one
year after such cause of action accrues.

Government End Users. This provision applies to all Software acquired directly or indirectly by or on behalf of
the United States Government. The Software is a commercial product, licensed on the open market at market
prices, and was developed entirely at private expense and without the use of any U.S. Government funds. If the
Software is supplied to the Department of Defense, the U.S. Government acquires only the license rights
customarily provided to the public and specified in this Agreement. If the Software is supplied to any unit or
agency of the U.S. Government other than the Department of Defense, the license to the U.S. Government is
granted only with restricted rights. Use, duplication, or disclosure by the U.S. Government is subject to the
restrictions set forth in subparagraph (c) of the Commercial Computer Software Restricted Rights clause of FAR
52.227-19.

Export Restriction. LICENSEE will not remove or export from the United States or the country originally
shipped to by LICENSOR (or re-export from anywhere) any part of the Software or any direct product thereof
except in compliance with applicable export laws and regulations, including without limitation, those of the U.S.
Department of Commerce.

Miscellaneous. This Agreement contains the entire understanding of the parties and supersedes all other
agreements, oral or written, including purchase orders submitted by LICENSEE, with respect to the subject
matter covered in this Agreement The delay or failure of either party to exercise any right provided in the
Agreement shall not be deemed a waiver. All notices must be in writing and shall be delivered by hand (effective
when received) or mailed by registered or certified mail (effective on the third day following the date of mailing).
The notices addressed to LICENSOR shall be sent to its address set out above. If any provision is held invalid,
all others shall remain in force. LICENSEE may not assign, pledge, or otherwise transfer this agreement, nor any
rights or obligations hereunder in whole or in part to any entity. Paragraph headings are for convenience and
shall have no effect on interpretation. In the event that it is necessary to undertake legal action to collect any
amounts payable or to protect or to defend against the unauthorized use, disclosure, distribution, of the Software
hereunder and/or other violation of this Agreement, LICENSOR shall be entitled to recover its costs and
expenses including, without limitation, reasonable attorneys' fees.
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Chapter 1. Introducing Acronis
Recovery for MS SQL Server

This chapter provides general information about a new Acronis product - Acronis
Recovery for MS SQL Server, its features and advantages. You will learn about
supported databases, operating systems and platforms.

1.1 What is Acronis Recovery for MS SQL Server
Acronis Recovery for MS SQL Server offers a fast and reliable disaster recovery solution
to protect your Microsoft SQL Server database. Acronis Recovery for MS SQL Server
provides proven database backup technology that will drastically reduce disaster
recovery time so you can be running again in minutes instead of hours.
One-step Recovery and Automated Recovery to Point-of-Failure reduce downtime and
assist your organization in improving your Recovery Time Objective (RTO). Rolling
Snapshot enables near-instantaneous recovery in cases of human error or logical data
corruption.
Acronis Recovery for MS SQL Server is an excellent compliment to the award-winning
Acronis True Image suite of disaster recovery and system migration products that use
patented disk-imaging technology. Together they deliver comprehensive server system
backup and restore plus full Microsoft SQL Server database protection — a winning
disaster recovery plan combination.
• Smaller, more manageable archives
Award-winning Acronis technology provides superior image file optimization.
Customizable compression rates reduce the amount of data to store and
transfer, leading to direct cost savings in storage and labor
•

Faster Disaster Recovery
One-step Recovery and Automated Recovery to the Point-of-Failure make
recovery faster and help organizations meet superior Recovery Time
Objective (RTO). Rolling Snapshot can recover immediately in case of
human error or logical data corruption

•

Encryption for Security
Protect companies' most valuable data with industry-standard encryption

•

Centralized Management
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The Acronis Recovery for MS SQL Server Management Console automatically
detects all database servers on the network. The servers are displayed
clearly with status information, making it easy to manage enterprise-wide
installations
•

Easy Administration
Intuitive wizard-driven GUI allows even non-DBAs to confidently configure
and implement professional backup strategies. Acronis Recovery for MS SQL
Server even lets you import an existing Microsoft SQL Server Maintenance
Plan in just a few clicks

1.2 Why Acronis Recovery for MS SQL Server
Comprehensive recovery requires more than just data backup. Your Microsoft SQL
Server database contains tables, logs, and other components that structure the data.
Using Acronis Recovery for MS SQL Server, a cohesive and intuitive backup solution, is
critical to ensure a secure live database backup that can be quickly recovered.
Recovery is now made easy with automated system restore to point-of-failure. No need
to walk through menus to get your system back online. This one-step process will
return your database to the last known good state just before failure. Erroneous
transactions will no longer cost you minutes or hours in recovery.
This powerful product includes an intuitive wizard-driven GUI that guides you through
the scheduling process and reduces the possibility for errors. The Acronis Recovery for
MS SQL Server Assistant creates a Disaster Recovery Plan for your environment,
delivering step-by-step instructions for recovery. Anyone, whether an experienced DBA
or not, can schedule backup jobs and restore a system rapidly. Acronis even provides
FTP capability for storing your backup on any FTP server, worldwide.

1.3 Features
With Acronis Recovery for MS SQL Server you get the following features:
•

Tuning Backup Strategy with Acronis Recovery for MS SQL Server
Assistant
Acronis Recovery for MS SQL Server Assistant provides an intuitive GUI for
easy creation and implementation of a backup strategy, even without DBA
experience

•

Recovery to a Selected Point-in-Time
Transaction Logs Backup combined with intuitive simple GUI allows
databases to be restored to a selected point-in-time, for example, just
before an erroneous transaction

•

Automated recovery to point-of-failure
Automated recovery to point-of-failure allows easy one-step recovery to a
point just before failure or disaster with no loss of data

•

Disaster Recovery Plan
Automatically creates and e-mails Disaster Recovery Plans with step-by-step
instructions on recovering databases. The guided process makes it possible
for staff to restore databases quickly, even without DBA skills

•

Importing a preexisting Microsoft SQL Server Maintenance Plan
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Configure your backup strategy in seconds by importing a preexisting
Microsoft SQL Server Maintenance Plan
•

Rolling snapshot creation
Automatically created snapshots allow the database to be recovered in
seconds - in cases of data corruption or human error - by simply discarding
changes (for Microsoft SQL Server 2005 Enterprise Edition only)

•

Encryption
Protect backups with strong industry-standard encryption technology. AES
(Advanced Encryption Standard) is available with three key lengths – 128,
192 and 256 bits to balance performance and protection as desired

•

Compression
Create backups up to 10 times smaller than the original uncompressed
format. Three compression levels let you optimize for faster performance,
smaller size, or a balance of both

•

Bandwidth Throttling
Control bandwidth usage to keep the backup process transparent to
network users

•

Notifications
Configure notification via e-mail and SNMP

•

Automated recovery staging

•

Every restore scenario can be executed in one step. There is no need to
manually restore from different archives keeping in mind the database state

•

Hot Backup
Backup can be performed while the database is online and serving clients
allowing 24/7 availability

•

Restore to Another Microsoft SQL Server Version
Allows migration to another Microsoft SQL Server version by simply
restoring the database to a newer Microsoft SQL Server Installation

•

Scheduling complete backup strategy
Schedule the complete backup strategy, including Full, Differential and
backup of Transaction Logs in one action

•

Software Development Kit (shipped separately)
Acronis Recovery for MS SQL Server is shipped with SDK allowing customers
to tailor backups and restores in line with their processes and regulations

1.4 Key Features
Storage Locations:
•

Local HDD

•

Acronis Backup Server

•

Centralized storage repository

•

Network shares
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•

SAN, NAS

•

FTP

•

Tapes, Autoloaders, Tape Libraries

Backup Modes:
•

Full

•

Differential

•

Transaction Logs

Backup Features:
•

Tune backup strategy with Acronis Recovery for MS SQL Server Assistant

•

Backup several databases at once

•

Backup files/filegroups

•

Rolling snapshots on Microsoft SQL Server 2005 Enterprise

•

Protect backups with industry-standard encryption

•

Backup system databases

•

Verify backup

•

Keep many versions of archives

•

Online backup

Restore Features
•

Recovery from backup history

•

Recovery to point-in-time

•

Automated Recovery to point-of-failure

•

One-step recovery

•

Automated recovery staging

Scheduling Features
•

Schedul backup and restore jobs

•

Intuitive easy-to-use GUI – does not require DBA skills

•

Advanced backup strategy support

•

Import existing Microsoft SQL Server maintenance plans

Enterprise Features
•

Centralized management

•

Notifications

•

Reporting

•

SDK

•

Bandwidth throttling

•

Disaster Recovery Plan
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•

Remote agent installation

1.5 Supported Microsoft SQL Server versions
•

Microsoft SQL Server 7.0 (SP4+)

•

Microsoft SQL Server 2000 (SP3a+, both 32-bit and 64-bit versions)

•

Microsoft SQL Server 2000 Desktop Engine Release A

•

Microsoft SQL Server 2005 (both 32-bit and 64-bit versions)

•

Microsoft SQL Server 2005 Express

Please note, Acronis Recovery for MS SQL Server is not a cluster-aware
product.

1.6 Supported Platforms
•

x86

•

x64

1.7 Supported Operating Systems
•

Windows 2000 (SP4+)

•

Windows XP (SP1+)

•

Windows Vista

•

Windows Server 2003 (both 32-bit and 64-bit versions)

1.8 License Policy
Acronis Recovery for MS SQL Server licensing is based on the number of servers on
which Acronis Recovery for MS SQL Server Agent is to be installed. You will need a
unique serial number to install every single Acronis Recovery for MS SQL Server Agent.
Acronis Recovery for MS SQL Server is provided with three types of licenses:
Permanent – allows you to use the fully functional product without any time
limitations (permanent serial number is required)
Trial - allows you to use the fully functional product for 14 days (trial serial number is
required)
Registered – used for customers, registered on the Acronis web site. It also allows
working with the fully functional product for 14 days (no serial number is required)

Obtaining Permanent Serial Numbers
Obtaining a permanent serial number depends on the way you purchase Acronis
Recovery for MS SQL Server:
•

you will find it in a CD box if you buy a licensed Acronis Recovery for MS
SQL Server CD

•

you can receive it after registering on the Acronis web site in case you
download the product (also during installation of the product)
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Trial Serial Numbers
Acronis allows you to have a trial serial number to be able to use Acronis Recovery for
MS SQL Server for 14 days without buying the product. You may obtain the trial serial
number in one of the following ways:
• in a CD box
• contacting Acronis sales representatives. See
http://www.acronis.com/enterprise/download/sn/ADBSQL/
If you downloaded a trial version of Acronis Recovery for MS SQL Server from our web
site and want to buy a permanent license to continue using the product, please contact
our sales representatives. In this case you will not have to download the product
again, but only enter a registered serial number during the installation.
Note, the Management Console should be connected to Acronis Recovery for
MS SQL Server, otherwise the Registration menu item will not be presented in
the Help menu.
The number of Acronis Recovery for MS SQL Server Management Console installations
is not limited.

1.9 Technical Support
As part of a purchased annual Support charge you are entitled to Technical Support as
follows: to the extent that electronic services are available, you may electronically
access at no additional charge, Support services for the Software, which Acronis shall
endeavor to make available twenty four (24) hours a day, seven (7) days per week.
Such electronic services may include, but are not limited to: user forums; softwarespecific information; hints and tips; bug fix retrieval via the internet; software
maintenance and demonstration code retrieval via a WAN-accessible FTP server; and
access to a problem resolution database via Acronis customer support system.
Support shall consist of supplying telephone or other electronic support to you in order
to help you locate and, on its own, correct problems with the Software and supplying
patches, updates and other changes that Acronis, at its sole discretion, makes or adds
to the Software and which Acronis makes generally available, without additional
charge, to other licensees of the Software that are enrolled in Support. Upon mutual
agreement by both parties, Acronis shall: (i) supply code corrections to you to correct
Software malfunctions in order to bring such Software into substantial conformity with
the published operating specifications for the most current version of the Software
unless your unauthorized modifications prohibit or hamper such corrections or cause
the malfunction; or (ii) supply code corrections to correct insubstantial problems at the
next general release of the Software.
More information about contacting Acronis Technical Support is available at the
following link: http://www.acronis.com/enterprise/support/
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Chapter 2. Understanding Acronis
Recovery for MS SQL Server

This chapter provides common information about working with Acronis Recovery for
MS SQL Server.

2.1 Components
Acronis Recovery for MS SQL Server includes the following components:
•

Management Tools including Acronis Recovery for MS SQL Server
Management Console

•

Acronis Recovery for MS SQL Server Agent

•

SDK (shipped separately)

2.1.1
Acronis Recovery for MS SQL Server Management
Console
Acronis Recovery for MS SQL Server Management Console is a tool for managing data
backup/restore on the local network from a single location. Using it you can install
agents remotely, schedule tasks, recover data remotely, set backup/restore options on
remote database servers, and import a preexisting maintenance plan.

2.1.2

Acronis Recovery for MS SQL Server Agent

The Acronis Recovery for MS SQL Server Agent is installed on the computers on which
you want to backup/restore a Microsoft SQL Server database.

2.2 Components Integration
Acronis Recovery for MS SQL Server Management Console is installed on the computer
from which you plan to manage operation processes on remote database servers.
After issuing a backup or restore command from the Management Console, Acronis
Recovery for MS SQL Server sends a request to the Acronis Recovery for MS SQL
Server Agent to retrieve the required instance or database from Microsoft SQL Server
and sends it to Acronis Recovery for MS SQL Server, which backs up the selected data.
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Below are diagrams describing interaction between Management Console, Agent and
SDK.

Integration between Acronis Recovery for MS SQL Server and Acronis Recovery for MS
SQL Server Agents

Integration between Acronis Recovery for MS SQL Server SDK and Acronis Recovery
for MS SQL Server Agents
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Chapter 3. Installation of Acronis
Recovery for MS SQL Server

From this chapter you will learn how to install Acronis Recovery for MS SQL Server
components both locally and remotely.

3.1 Minimum System Requirements
Acronis Recovery for MS SQL Server requires the following hardware:
•

Pentium processor or higher

•

512 MB RAM

•

Mouse (recommended)

3.2 Security Policy
3.2.1 Credentials
Acronis Recovery for MS SQL Server obtains access to networked computers using two
types of credentials.
1. Credentials with Guest Rights – used for access to configuration and status
data on each computer. The credentials you provide during Acronis Recovery for
MS SQL Server installation will be applied to all networked computers. This is
convenient for domain administrators, who can create a domain user account with
guest rights and remote access right to every computer. In a workgroup, it would
also make sense to create identical accounts with guest rights on each computer
accessed by Acronis Recovery for MS SQL Server.
If you do not wish to create a uniform account, provide guest credentials for each
computer after the installation and initial network discovery via Manage
Computer -> Set Credentials.
You can combine both methods, for example, set a uniform account for domain
members and set individual accounts for members of a workgroup.
2. Administrator Credentials – used for performing migration, deployment or other
tasks which require such rights. These are entered during creation of tasks.
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Naturally, you are free to use administrator credentials for both purposes. This will
work, but make sure it conforms to the security policy set in your network.

3.2.2 Firewall Settings
Acronis Recovery for MS SQL Server uses the following ports for remote operation:
•

server (Acronis Recovery for MS SQL Server Agents) UDP port: 9876

•

server (Acronis Recovery for MS SQL Server Agents) TCP port: 9876, if busy
choose a port at random

•

client (Acronis Recovery for MS SQL Server) UDP port: 9877, if busy choose
a port at random

You might have to set the appropriate firewall access options. Options for the Windows
Firewall, included in Windows XP Service Pack 2, Windows 2003 Server and later
Windows versions, are set automatically during installation of Acronis Recovery for MS
SQL Server components. However, make sure that the option File and Printer
Sharing in the Control panel -> Windows Firewall -> Exceptions is enabled on
the remote computer, before the remote operation starts.

3.3 General Rules of Installation
Acronis Recovery for MS SQL Server components and their features can be installed in
multiple configurations, in terms of distributing the components and features among
the networked computers.

3.3.1
Installing Acronis Recovery for MS SQL Server
Components
There are two ways to install Acronis Recovery for MS SQL Server components – local
and remote.
To install Acronis Recovery for MS SQL Server Management Console and Acronis
Recovery for MS SQL Server Agent locally:
•

run the Acronis Recovery for MS SQL Server setup file

•

in the Install Menu, select the program to install: Acronis Recovery for MS
SQL Server Management Tools or Acronis Recovery for MS SQL Server
Agent

•

follow the install wizard instructions on the screen
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It is recommended that you install Acronis Recovery for MS SQL Server Management
Console first. This will allow you to install Acronis Recovery for MS SQL Server Agent
remotely from the Management Console to any networked computer (for information
about the remote installation see 3.3.2 “Installing Acronis Recovery for MS SQL Server
Agent remotely”).
In addition, Acronis Recovery for MS SQL Server supports the Microsoft Installer utility
(msiexec.exe) and its commands, so that you can install Acronis Recovery for MS SQL
Server components from a command line. MSI installation command and options are
listed in Appendix B.

3.3.2

Installing Acronis Recovery for MS SQL Server Agent
Remotely

To install Acronis Recovery for MS SQL Server Agent remotely on a database server,
you need Acronis Recovery for MS SQL Server Management Console installed on the
local computer. The remote system must meet the requirements described in 3.1
“Minimum System Requirements”.
Run Acronis Recovery for MS SQL Server and click Install Acronis Recovery for MS
SQL Server Agent in the Pick a Tool pane.
1. Specify the location of installation files of the Acronis Component you want to
install.
•

Select from the registered components (by default)

•

Search removable media for the required installation files

•

Search for the installer in the following location
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Click Next to continue.
2. Select the program you want to install on the remote computer from the list
and click Next.

3. Enter a serial number for the selected product. For information about obtaining
a serial number, see section 1.8 “License Policy”. The Next button will not be
active until you enter a serial number.
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4. Select the computer in the Computer field: enter a computer name manually
or click Browse… and select the required computer from the tree. Enter a
User name and password into the corresponding fields to access the selected
computer. By checking the Save password you can save the password for
future connections.

5. The summary page displays all operations, which will be performed. Click
Proceed to install Acronis Recovery for MS SQL Server Agent on the remote
computer.
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By connecting to a remote computer with Acronis Recovery for MS SQL Server Agent
installed, you can set up backup and recovery tasks, browse logs, import existing
maintenance plans for Microsoft SQL Server databases.

3.3.3

Extracting Acronis Recovery for MS SQL Server
Components

For installing Acronis Recovery for MS SQL Server from the command line, you will
need to extract the .msi file prior to starting the installation process. Here are the steps
for extracting the file:
•

run the Acronis Recovery for MS SQL Server setup file;

•

in the Install Menu, right-click on the component name and select Extract;

•

select a location for the setup file and click Save.
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3.3.4 Removing Acronis
Components

Recovery

for

MS

SQL

Server

You can remove any Acronis Recovery for MS SQL Server component separately by
selecting Control panel -> Add or Remove Programs -> <component name> > Remove.
Component names are: Acronis Recovery for MS SQL Server and Acronis Recovery for
MS SQL Server Agent.
Follow instructions on the screen. You may need to reboot your computer to complete
the uninstallation.
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Chapter 4. Getting started with
Acronis Recovery for MS SQL Server

This chapter will help you to start working with Acronis Recovery for MS SQL Server,
and will guide you through connecting to a remote server, and remote installation of
Acronis Recovery for MS SQL Server Agent.

4.1 Running Acronis Recovery for MS SQL Server
Management Console
To run Acronis Recovery for MS SQL Server Management Console, select Start ->
Programs -> Acronis Recovery for MS SQL Server Management Console ->
Acronis Recovery for MS SQL Server Management Console.

4.2 Acronis Recovery for MS SQL Server Workspace
Acronis Recovery for MS SQL Server workspace includes the Acronis Recovery for MS
SQL Server Management Console window - the primary tool for managing data
backup/restore on local and remote computers where Acronis Recovery for MS SQL
Server Agent is installed.
The workspace consists of the main area with operation icons, as well as the menu,
the toolbar, and the common tasks bar. On the left there is a sidebar, featuring the
Computers or Help panels.
Note, the content of the main window depends on whether Acronis Recovery
for MS SQL Server Management Console is disconnected or connected to a
remote server.

4.2.1 Main Area
The main area of Acronis Recovery for MS SQL Server workspace contains Task and
Tools groups.
Before you connect to a database server where Acronis Recovery for MS SQL Server
Agent is installed, main program window will contain operation icons that allow you to
navigate and manage computers.
The Pick a Task group contains one operation:
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•

Connect to a Remote Computer – connect to a remote server where
Acronis Recovery for MS SQL Server Agent is already installed

If you select a server in the Computers pane, on which Acronis Recovery for MS SQL
Server Agent is not installed, Acronis Recovery for MS SQL Server workspace will
contain two operation icons in the Pick a Tool group:
•

Add Servers – add a database server to the group

•

Install Acronis Agents – install Acronis Agents on remote computers

As soon as you are connected to a database server where Acronis Recovery for MS
SQL Server Agent is installed, your workspace shows operations you can execute on
this server, such as backup or restore, managing tasks, etc.
In this case the main area contains operation icons divided into two groups.
The Pick a Task group contains the following operations:
•

Backup – create a database backup archive
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•

Restore – restore databases from a previously created archive

•

Backup Location Clean-up - clean database backup locations

•

Disaster Recovery Plan – generate step-by-step instructions on how to
restore your databases in case of any kind of failure
The Pick a Tool group contains the following items:
•

Manage Tasks – manage tasks scheduled on a computer

•

Logs – open the Log Viewer window

•

Import Maintenance Plan – set backup options by importing a
preexisting backup strategy

4.2.2 Computers Pane
The Computers pane is located on the left side of the main program window and
contains computers (with their databases servers displayed), discovered by the system
or added manually.
Acronis Recovery for MS SQL Server Management Console allows you to connect to a
remote computer where Acronis Recovery for MS SQL Server Agent is already installed,
or to install Acronis Recovery for MS SQL Server Agent remotely.
At the top of the Computers pane there is a toolbar with the following buttons:
•

Add server - opens the Add Server window, where you can specify a
server to be added to the tree

• Discover servers - automatically finds servers on the network and adds
them to the tree
• Delete server - removes the selected server from the tree

4.2.3 Program Menu
The program menu bar features the Tasks, Tools, View and Help items.
The Operations menu contains two available operations:
•

Backup - create a database backup archive
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•

Restore - restore databases from a previously created archive

•

Backup Location Clean-up - clean database backup locations

•

Disaster Recovery Plan – generate step-by-step instructions on how to
restore your databases in case of any kind of failure
The Tools menu contains three available operations:
•

Manage Tasks – manage tasks scheduled on a computer

•

Logs – open the Log Viewer window

•

Import Maintenance Plan – set backup options by importing a
preexisting backup strategy

•

Options – open a window for editing default backup/restore options,
setting text appearance (fonts), configuring notifications etc
The View menu contains items for managing the look of the program window:
•

Status Bar – enables/disables the status bar

4.2.4 Help Menu
The Help menu is used to invoke help and obtain information about Acronis Recovery
for MS SQL Server.
To view the Help panel, disable the Computers Tree option in the View menu.

4.2.5 Status Bar
At the bottom of the main window, there is a status bar divided into two parts. The left
side briefly describes the selected operation; the right side indicates operation progress
and results. If you double-click on the operation results, you will see the logs window.

4.3 Navigation
At the top on the Computers pane there are four buttons; clicking them allows you to
add new servers to the tree manually, to start the discovering process, to delete a
server from a tree if needed, or to refresh the Computers Tree.
Computers with Acronis Recovery for MS SQL Server Agent already installed are
marked with a green icon.
Select the required server from a tree to perform the required operation (connecting,
installing Acronis Recovery for MS SQL Server Agent remotely).
To hide the Computers pane and view Help topics, click on the Show or Hide button
from the menu.
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4.4 Management
Acronis Recovery for MS SQL Server Management Console allows installation Acronis
Recovery for MS SQL Server components on remote computers. To perform any of
these operations you will need administrator rights on the target machine.
To connect to the server click Connect to a Remote Server in the Pick a Task pane
(see 4.7 “Connecting to a Remote Database Server”). In case Acronis Recovery for MS
SQL Server Agent is not installed on a server, click Install Acronis Agents in the
Pick a Tool pane (see Chapter 3 “Installation”).
To add a new server to the tree pane, click Add Servers in the Pick a Tool pane (see
4.6 “Adding Servers”).

4.5 Discovering Servers
The purpose of discovering servers is to find servers on the network automatically and
add them to the list in the Computers pane. The first time the program is executed,
the list in the Computers pane list is empty and you will be prompted to discover
servers. In order to be able to create backup and recovery operations on servers, you
should launch the search or add servers to the list manually.
To discover servers click on the Discover Computers icon from the Computers pane
on the left. You will be asked if you want to search for database servers on the
network. Click YES to do it immediately, or NO to do it later. Discovery will update the
current status of all computers already included in the list.
If, for any reason, a server cannot be found with this tool, you can add it manually to
the tree (see 4.6 “Adding Servers”).
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4.6 Adding Servers
If, for any reason, a server cannot be found with the Discover Computers tool, you can
add it to the tree manually.
You can apply any discovery operation later as required. The operation will add newly
connected servers to the list in the Computers pane. At the same time, discovery will
update the current status of all computers already included in the list.
You can start an Add Computer dialog to add servers to the tree of the Computers
pane in several ways:
•

Click on the Add Servers icon in the main area

•

Click on the Add Servers button in the Computers pane toolbar

1. Enter the server name or IP address manually in a Server field or choose it
from the drop-down list. You can also click Browse to view all available
computers and select one you want to add.
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2. Click OK to add the server to the tree.

4.7 Connecting to a Remote Database Server
In order to perform any operation on a remote database server, you must first connect
to it. Once connected, you can manage tasks: set up backup/restore options on remote
database servers and schedule backup, restore and backup location clean-up tasks.
To establish a remote connection, select a server in the Computers pane and click
Connect to a Remote Computer in the right pane. If you have connected to this
server before, Acronis Recovery for MS SQL Server will use credentials for accessing
the computer automatically. Otherwise a dialog window will be opened:
•

In the Computer field, enter the name or the IP address of the computer
or select a computer from the drop-down list, by clicking the Browse...
button

•

To provide credentials for accessing the computer, click the Options>>
button

•

Specify username and password on the server you want to connect to, in
the corresponding fields

•

Select the Save Password check box if you want to save the password.

Having provided all the necessary information for connection, click Connect to
establish connection.
If Acronis Recovery for MS SQL Server Management Console cannot connect
to the remote computer, which was not rebooted after installing Acronis
Recovery for MS SQL Server Agent, connection may be established with
explicit credentials.
As soon as you connect to a database server, you can manage tasks as if it were a
local computer.
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4.8 Remote Installation of Acronis Recovery for MS SQL
Server Agent
The remote installation of Acronis Recovery for MS SQL Server Agent is described in
detail in 3.3.2.
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Chapter 5. Creating Backup Archives

This chapter provides general information about backup methods, describes how to
backup Microsoft SQL Server databases, and which options can be set using Acronis
Recovery for MS SQL Server.

5.1 General Information
Backup is crucial to maintaining timely and consistent record of your databases for
recovery in case of failure. Acronis Recovery for MS SQL Server offers an easy and
flexible process for creating of backup archives.

5.1.1 What is a backup?
The concept of backing up data is based on copying it to a safe place to restore when
necessary. With an active database you need to backup and protect more than just
your database files and data. Databases include many components, such as transaction
logs, that must be backed up as well to ensure a fully functioning database upon
restoration.
Acronis Recovery for MS SQL Server is a tool that backs up the necessary tables, data,
and user-defined objects, but treats the database not just as a combination of files.
When the backup procedure starts, Acronis Recovery for MS SQL Server finishes all the
active transactions, makes a snapshot of the database and resumes the transactions
immediately. The database idle state is minimal; and the backup will be written to the
archive location while the database is online.
Using this process to back up the database ensures that the restored copy will
be operational as is. Since the copy is made according to the snapshot, no
transactions made after the start of the process will be included into the
current backup.
Acronis Recovery for MS SQL Server backs up transaction logs separately. See 5.1.2
“Backup Methods” for detailed information.

5.1.2 Backup Methods
Acronis Recovery for MS SQL Server can create full, differential and Transaction Log
backups for comprehensive protection of your data from hardware failure, user errors
or even natural disaster.
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A full backup contains all data at the moment of backup creation – a complete
database or instance. You can recover the entire database by restoring the database
from a full database backup to a chosen location. Enough of the transaction log is
included in the backup to let you recover the database to the time when the backup
finished. When the database is recovered, uncommitted transactions are rolled back.
The restored database matches the state of the original database when the backup
finished, minus any uncommitted transactions.
For a small database that can be backed up quickly, it is convenient to use only full
database backups. However, as the database becomes larger, full backups take more
time to finish and require more storage space. Therefore, for a large database, you
might want to supplement full database backups with differential backups.
A full backup can form a base for further differential backup or can be used as a
standalone archive.
A differential backup creates an independent file, containing all changes made
against the initial full archive.
A standalone full backup may be an optimal solution if you often roll back the database
to the initial state. In this case, you do not need to re-create the initial full backup, so
the backup time is not crucial, and the restore time will be minimal.
Alternatively, if you are interested in saving the last data state to be able to restore it
in case of a database failure, consider the differential backup. It is particularly effective
if your data changes tend to be small in comparison to the full data volume.
The transaction log records all transactions and database modifications made by
each transaction. The transaction log is a crucial component of the database and, if
there is a system failure, the transaction log might be required to bring your database
back to a consistent state.
If you are backing up filegroups, the transaction logs will be backed up along with the
full backup. Backing up transaction logs prevents data loss after the last backup and
lets you restore the database state to an arbitrary point in time in order to undo the
harmful changes.
To choose the appropriate backup method (or methods), you have to identify the
requirements for the availability of your data in order to choose the appropriate backup
strategy. Your overall backup strategy defines the type and frequency of backups as
well as the type and capacity of the hardware required for the archive location. See
5.1.3 “Which Backup Strategy to Choose?” for our recommendations.

5.1.3 Which Backup Strategy to Choose?
Follow the recommendations below to define the best backup strategy for your
organization:
•

•

Database activity is low to medium:
-

Full backup once a week

-

Differential backup once a day

-

Transaction Logs backup every two to four hours

Database size is small to medium, but activity is high:
-

Full backup twice a week

-

Differential backup twice a day
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•

Transaction Logs backup every hour

Database size is large and activity is high, recovery model is Full or BulkLogged:
- Full backup once a week
- Differential backup once a day
- Transaction Logs backup every twenty minutes

•

Database size is large and activity is high, recovery model is Simple:
-

Full backup once a week

-

Differential backup twice a day

For advice on creating the best strategy you can also rely upon Acronis Recovery for
MS SQL Server Assistant while working with the Create Backup wizard. See 5.2.6 for
detailed information.
We recommend that you do not to use several third-party backup tools
simultaneously since backup operations may conflict or affect the operation of
your databases. Instead, combine different backup methods to protect your
data with Acronis Recovery for MS SQL Server.

5.1.4 Recovery Models
There are three database recovery models: Full, Simple and Bulk-logged. In most
cases databases use the simple or full recovery models.
Full Recovery Model
Full recovery model requires backing up logs, which allows you to restore to the point
in time just before the data was corrupted and prevent data loss.
The disadvantage of this recovery model is that it requires storage space and makes
restoration slower and complicated.
Simple Recovery Model
The Simple recovery model does not store transaction logs, so you can recover your
databases only to the point in time when the last backup was created. Therefore, it is
recommend that you create backups (full or differential, in accordance with the backup
strategy you defined) often enough to prevent significant data loss. For critical
databases it is better to use the full recovery model.
Bulk-logged Recovery Model
Bulk-logged recovery model uses transaction logs for non-bulk operations fully logged
and bulk operations minimally logged. Data may be lost when restoring from bulk
operations (e.g. SELECT INTO).
The bulk-logged recovery model requires log backups. It is an adjunct of the full
recovery model and provides recovery to the end of any backup (but not to any pointin-time). In case the log was damaged or bulk-logged operations occurred after the
latest log backup, data changes will be lost. This is the least secure recovery model.

34

5.1.5 Backup Levels
Acronis Recovery for MS SQL Server allows backs up databases, as well as separate
filegroups.
You can choose to back up databases by separate filegroups when the database size
and performance requirements make it not practical to create full database backups. In
this case, each time the task is being executed, only one filegroup will be backed up.
As with instances and databases, you can create full and differential backups for
filegroups as well, but this is available for Microsoft SQL Server 2000 only.

5.1.6 Disaster Recovery Plan
With Acronis Recovery for MS SQL Server you can create a Disaster Recovery Plan.
This plan provides all the necessary information about the server and databases in the
form of step-by-step instructions restoring the entire database in case of failure,
disaster or data corruption.
With the Disaster Recovery Plan any person, even non-DBAs, will be able to restore the
system in the shortest possible time. This plan helps to reduce issues during the
recovery of databases.
It is recommended to update and test the disaster recovery plan from time to time to
be sure that the company’s staff is able to recover lost or corrupted data efficiently.
See Chapter 6 “Disaster Recovery Plan” to learn how Acronis Recovery for MS SQL
Server can help you to generate the disaster recovery plan.

5.1.7 Backing up to Tape Libraries and Tape Drives
Acronis Recovery for MS SQL Server supports tape libraries, autoloaders and SCSI tape
drives as storage devices.

Backing up to Tape Libraries and Autoloaders
A tape library is a high-capacity storage device consisting of one or more tape drives
and a loader, which automatically selects and loads multiple tape cartridges, using
barcode identification. Tape libraries with only one drive and loader are known as
autoloaders.
Tape libraries are widely used as an efficient repository for long-term stored archival
data. Once the tape library is full, old data is progressively overwritten by new data.
With tape library support, Acronis Recovery for MS SQL Server can store several
backup chains from different machines. Please review Acronis True Image Echo
Enterprise Server User’s Guide on how to backup to a tape drive in the network
(section 3.8.3 “Setting up Backup to a Tape or a Tape Library in the Local Network” of
the Echo User’s Guide).

Backing up to Tape Drives
SCSI tape drives are accessible both remotely using the Acronis ® Backup Server
(shipped with Acronis True Image Echo Enterprise Server) and locally when it is
connected to the computer that is being backed up.
The tape drive, connected to a computer being backed up, will appear in the list of
backup destination devices along with other available drives. For instructions on how to
enable backup to a tape drive connected to a remote computer, see Acronis True
Image Echo Enterprise Server documentation for instructions on how to enable backup
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to a tape drive in the local network (section 3.8.3 “Setting up Backup to a Tape or a
Tape Library in the Local Network” of the User’s Guide).
Backup and restore on a tape drive proceed in the same way as with other devices
with the following exceptions.
1. You do not have to provide filenames for backups.
2. As soon as the tape is full and the Acronis Recovery for MS SQL Server
Management Console is connected to the computer, a dialog window with a
request to insert a new cartridge will appear.
3. If the tape already contains data, but is not full, new contents will be
appended.
You may experience short pauses that are required to rewind the tape.
A low-quality or old tape, as well as dirt on the magnetic head, may lead to
pauses that can last up to several minutes.
Acronis Recovery for MS SQL Server can backup to remote tape drives when using
Acronis Backup Server (shipped with Acronis True Image Echo Enterprise Server).

5.2 Backup
To restore lost data or roll back a database to a certain state, you must first create a
database backup file. The Create Backup wizard allows you to schedule the creation
of archives and set the required options.
To launch the wizard, click on the backup operation icon in the main workspace.
You can use <Alt>+<N> to go to the next page and <Alt>+<B> to go to the
previous page of any Acronis Recovery for MS SQL Server wizard.

5.2.1 Defining a Backup Strategy
In the first step of the Create Backup wizard you will define the backup strategy.
Acronis Recovery for MS SQL Server provides three ways to define the strategy:
•

Use Acronis Recovery for MS SQL Server Assistant

•

Define strategy manually

•

Create a backup now
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If you are not sure which backup strategy to choose, use Schedule a backup task
with Acronis Recovery for MS SQL Server Assistant (selected by default). See
5.2.6 for details.
If you know which backup method to use for your data, select the Schedule a
backup task manually option. In this case you will have to define backup methods
and schedule parameters for backup tasks.
To immediately run a backup task once select the Create a Backup Now option. In
this case you a full backup will be created.
For more information about backup methods see 5.1.2 “Backup Methods”.
Note, when backing up filegroups, transaction logs are always backed up
independently so that they are consistent with the database after recovery.

5.2.2 Specifying a Task Execution Account
In this step of the Create a Backup wizard you specify an account that is valid for the
computer housing databases you want to backup – task execution account. These
credentials will be used during each task execution for connecting to the server and by
default for connecting to the Microsoft SQL Server (if you do not specify another
account for Microsoft SQL Server while selecting the source to backup).
Thus, the task would run as if it was started by the specified user.
Enter the user name and password, then click Next. Note, the domain name must also
be specified if the user is a member of a domain (DOMAIN\Username).
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5.2.3 Selecting Objects to Back Up
In the left pane of the window select a server with Microsoft SQL Server installed and
specify Microsoft SQL Server instances or specific databases to back up. In case an
instance is selected, all associated databases will also be selected.
Information on the selected item is displayed in the right pane of the window: server
name, installed operating system and the number of Microsoft SQL Server instances.
In this step you can change the credentials for connecting to the server by clicking the
Change link (see 5.3.5 for details).

Selecting Instances to Back Up
When selecting an instance to back up Acronis will automatically backup all of the
databases associated with this instance, including system databases.
A list of instances can be obtained, with the connected user’s priviligies that
cannot be changed.

The right pane will display instance name, Microsoft SQL Server version, amount of
databases and their total size.
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You can also use the Change link to change the credentials for connecting to the
Microsoft SQL Server (see 5.2.3 for details).

Selecting Databases to Back Up
Select the specific database you want to back up. The right pane will display database
name, size, recovery model and status.
If the selected database is so large, that creating a backup archive may take several
hours, and performance requirements make it unsuitable to create a full database
backup, it makes sense to back it up in parts – by one filegroup at a time. For
example, if your database consists of several filegroups, on the first task run, the first
filegroup will be backed up, on the second run – the second filegroup, and so on.
Thus, each time this backup task is executed, only one filegroup will be backed up,
which will appreciably decrease the operation’s duration and will not influence on your
company’s database work.
Note, you can back up filegroups only while creating a full or differential backup.
To backup a database by separate filegroups, select the Back up only one
subsequent filegroup each time the task starts check box (by default this check
box is disabled and all filegroups of the selected database will be backed up each time
this task is executed).
Also you can change the credentials for connecting to the Microsoft SQL Server by
clicking the Change link (see 5.2.3 for details).

Setting rolling snapshots options
Acronis Recovery for MS SQL Server supports Rolling Snapshot (for Microsoft SQL
Server 2005 Enterprise Edition only). Rolling Snapshots make allow for nearinstantaneous recovery of Microsoft SQL Server 2005 databases in cases of human
error or logical data corruption.
To set options, click the Set Rolling Snapshots Options link.
In the opened window choose when the rolling snapshot will be made:
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•

Full backup is created - Rolling Snapshots will be created immediately
after creation of the full backup

•

Differential backup is created - Rolling Snapshots will be created
immediately after creation of the differential backup

•

Transaction log backup is created - Rolling Snapshots will be created
immediately after the creation of the transaction log
Please be aware that it is not possible to create Rolling Snapshots of the
master and model system databases.

Type the desired snapshot name prefix in the Name prefix field.
In the Maximum number of snapshots field, you can set the number of Rolling
Snapshots. For example if you maintain 8 snapshots the earliest snapshot will be
deleted automatically after the ninth snapshot is created.
Having defined the Rolling Snapshot creation options, click OK to save your settings.

Selecting System Databases to Back Up
Microsoft SQL Server maintains a set of system databases that are essential for the
operation of a server instance. You are encouraged to backup all system databases
after every significant change:
•

master – records all the system-level information for a Microsoft SQL
Server instance

•

model – used as the template for all databases created on the Microsoft
SQL Server instance

•

msdb – used by Microsoft SQL Server Agent for scheduling notifications
and tasks, recording operations

System databases can be restored from a backup created within the Microsoft SQL
Server version, which the server instance is currently running.
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After selecting the appropriate object for back up, click Next to continue.

5.2.4 Specifying Credentials
In the first step of this wizard you specified the default task execution account (see
5.2.1) so the backup task would run as it was executed by the specified user.
If you want to change the credentials for access Microsoft SQL Server, click the
Change link while selecting the source to backup.
There are two choices:
•

Use Windows Authentication

•

Use Microsoft SQL Server Authentication

Enter user name and password, then click OK.
The domain name must also be specified if the user is a member of a domain
(DOMAIN\Username).

5.2.5 Selecting a Backup Archive Location
Acronis Recovery for MS SQL Server supports the following places and media for
backup destinations:
•

Acronis Backup Server (shipped with Acronis True Image Echo™ Enterprise
Server)

•

Local HDD

•

Network shares, SAN, NAS

•

FTP

•

Tape drives, Autoloaders, Tape libraries
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Acronis Backup Server
This software application, when installed on a networked computer,
automatically manages backup archives and retention policies for the
specified location and ensures optimal usage of storage space. Outdated
archives will automatically be deleted as specified in the retention policies set
by the administrator. In addition, Acronis Backup Server facilitates the
creation and execution of group backup tasks.
Acronis Backup Server is shipped with Acronis True Image Echo Enterprise
Server.
Select the desired archive location from the folders tree or specify a backup location in
the Folder field.
We recommend you to store the archives of each task in a separate location
to avoid confusion during recovery.
Acronis Recovery for MS SQL Server guarantees the integrity of the backups
chain only in a separate archive. Thus, creation of a new archive will start a
new chain of backups. Acronis Recovery for MS SQL Server behavior does
not depend on what you want to backup (the entire database or only a
separate filegroup). Transaction logs are truncated before creating such a
chain to decrease the archive size and duration of the backup operation.

Please note that unsupported Acronis Backup Server versions will not be
displayed in the Acronis Backup Servers list. To provide compatibility with
Acronis Recovery for MS SQL Server, please install the up-to-date version,
available at: http://www.acronis.com/enterprise/download/ATIBS .

Note, Acronis Recovery for MS SQL Server does not display mapped network
drives in the Folders tree.
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Note, the further you store the backup archive from the original location, the
safer it will be in case of data damage. For example, saving the archive to
another hard disk will protect your data if the primary disk is damaged. Data
saved to a network disk or backup server will survive even if all your local
hard disks are down.
Acronis Recovery for MS SQL Server allows you to clean storage places to avoid storing
out of date archives. See Chapter 8 “Backup Location Clean-up” for details.

5.2.6 Using Acronis Recovery for MS SQL Server Assistant
The Acronis Recovery for MS SQL Server Assistant will help you with define backup
strategy and creation parameters. Answer a few questions and the Acronis Recovery
for MS SQL Server Assistant will choose and schedule the appropriate backup method
for protecting your company’s databases from loss or damage (see a table of backup
strategies in the end of this.

Performance
Decide what is most important to your operation – a strategy that requires less storage
space or faster data recovery.
Select an option:
•

Quick backup and smaller backup archives - backups are created fast
and occupy less space. However, recovery requires more time and you
cannot restore data to a point-in-time. This option is set by default.

•

Medium backup and recovery speed with average archive size backups require an average amount of disk space and backup speed is
normal. No restoration to a point-in-time.

•

Quick recovery but backups require more storage space - backups
will take more time to be created and occupy more disk space in
comparison to a quick backup. Recovery is faster and there is an
opportunity to restore data to any previous point-in-time.

Click Next to continue.
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Acceptable Data Loss
At this step specify a period of time when data changes significantly. This will help the
Acronis Recovery for MS SQL Server Assistant define the schedule for backup creation
– how often to run the backup operation and which backup method to choose.
Select one of the following options:
•

10 Minutes – significant changes at least every ten minutes (selected by
default)

•

Hour – select this option if you want to backup the selected data hourly

•

Day - select this option if you want to backup the selected data daily

Click Next to continue.

Server Load During a Week
Specify the workload distribution on the database server during a week. The Assistant
will use this information to define a backup schedule according to your company’s
server’s load. The load information is used to determine when and what type of
backups to create to avoid data loss (backup creation frequency), as well as when to
execute the operation.
In the table there are three rows representing three levels of load (High, Medium and
Low), and seven columns representing seven days of the week.
By default the most widely used pattern is specified (selected cells are highlighted in
blue). To change the value for a certain day, click the appropriate cell.
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Click Next to continue.

Server Load During a Day
Specify workload distribution on the database server throughout the day. As in the
previous step, this information will help to define a backup schedule according to your
company’s server’s load.
In the table there are three rows representing three levels of load (High, Medium and
Low), and twenty four columns representing 24 hours of the day.
By default the most widely used pattern is specified (selected cells are highlighted in
blue). To change the value of a particular hour click, the appropriate cell.

Initial Task Starting
Specify a time for applying the selected scheme:
•

Now – select this option to execute the scheduled task immediately after
you finish the wizard
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•

On the specified date and time – the selected scheme will be applied at
the specified date. Note, that if there is no full backup when the first
differential or transaction log backup is to be performed, a full backup will
be performed independently of the actual date on which it is scheduled, so
you may consider setting this date on the day of the week, when load of
your server is not high

Click Next to view (and change if necessary) the schedule for backup tasks, created
by Acronis Recovery for MS SQL Server Assistant (see 5.2.8).

Table of Backup Strategies
The table below describes different backup strategies according to your requirements
for storage space and speed. The final strategy created by the Acronis Recovery for
MS SQL Server Assistant will be displayed in a Schedule page (see 5.6.3 for details).
Performance
Data change
rate

10 minutes

Hour

Day

Backup
Method

Quick backup
and smaller
archive size

Medium
archive size
and speed

Quick
recovery and
large archive
size

Full

Month

Week

Day

Differential

Day

Day

x

Transaction
logs

10 minutes

10 minutes

10 minutes

Full

Month

Week

Day

Differential

Day

Day

x

Transaction
logs

1 hour

1 hour

1 hour

Full

Month

Week

Day

Differential

Day

Day

x
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Transaction
logs

12 hours

12 hours

12 hours

5.2.7 Setting Backup Scheduling Parameters
If you used the Acronis Recovery for MS SQL Server Assistant, Acronis Recovery for
MS SQL Server will offer the appropriate schedule for the choices you made. Click Edit
to change existing schedule settings.
If you decided to define the backup strategy manually, you have to set a schedule for
each backup method. See Chapter 10 “Scheduling Tasks” for detailed information.
Click Add to add new schedule settings for the appropriate method (full, differential or
transaction logs). Clicking Delete will allow you to delete the existing schedule
settings.
All the settings you made are displayed in the Result field at the bottom of the
window. To save your settings, click OK.
To quit task scheduling without saving, click Cancel.
Note, Acronis Recovery for MS SQL Server allows you to set multiple schedules for one
task. For example, you should not only backup your data once a week, but also on the
last day of each month. You can specify Weekly and Monthly parameters to have the
necessary operation scheduled.

5.2.8 Backup Options
Select the backup options (pre/post commands, compression level etc.). You may Use
default options (see 5.3 for detailed information about backup options) or Set the
options manually. If you set the options manually, the settings will only be applied
to the current backup task.
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5.2.9 Specifying a Task Name and Providing Comments
On the Task Name and Archive Comments wizard page, you can provide a name
and comments for the backup task.
Enter a task name in the Task Name field to identify and organize tasks by operation
(edit, delete, etc.).
You may provide comments for the archives you create. The backup file size and
creation date are automatically appended to the description, so you do not need to
enter this information.

5.2.10 Backup Summary
The final stage of the backup is the summary window, which displays the list of
operations to be performed.
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Click Finish to save the created schedule or start the backup creation task
immediately. You will be redirected to the Task List automatically, where you can view
and edit created tasks.

5.3 Setting Default Backup Options
Acronis Recovery for MS SQL Server lets you set the backup options you want to use
as default for future tasks.
To edit the default backup options, select Tools -> Options from the main program
menu.
You will also still be able to edit the backup options while creating a backup task.
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5.3.1 Pre/Post Commands
You can specify commands (or even batch files) that will be automatically executed
before and after the backup procedure. For example, you may want to start/stop
certain Windows processes, or check your data before starting the backup operation.
You can use commands set by default, as well as specify your own commands.
Select Use commands, type commands manually or click Edit to configure the
command:
• Select commands to be executed before the backup process starts in the
Before backup process field. To create a new command or select a new
batch file click the Edit button.
• Select the command to be executed after the backup process ends in the
After backup process field. To create a new command or select a new
batch file click the Edit button.

5.3.2 Compression Level
Select the compression level for the backup. With higher compression ratios the
archive file size will be smaller but the backup process may take longer.
You can choose one of the compression levels for a backup archive:
• None - the data will be copied without any compression
• Normal - the recommended data compression level (set by default)
• High - higher archive compression level
• Maximum - maximum backup archive compression
• Ultimate – ultimate level of compression
Generally, it is recommended to use the default Normal compression level. You might
want to select Maximum compression so the backup archive occupies less storage
space.
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5.3.3 Backup Priority
You can set up the backup process priority:
• Low - the backup process will run slower, but it will not influence other
processes running on your computer
• Normal - the backup process will run with normal priority
• High - the backup process will run faster, but it may influence other
processes running on your computer
Changing the priority of a backup process can make it run faster or slower, but it can
also adversely affect the performance of other programs running simultaneously. The
priority of any process running in the system determines the amount of CPU usage and
system resources allocated to that process. Decreasing the backup priority will free
more resources for other CPU tasks.
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5.3.4 Backup Protection
Password
The preset is No Password.
You can password protect your archives so that they will be inaccessible to others.
Enter a password in the text field and confirm it. The password is case sensitive.
Please keep in mind that in the Restore Data wizard, Acronis Recovery for MS SQL
Server will ask for a password after you select a folder within the archive location. Only
those archives that were protected with the password you typed in or non passwordprotected archives will be displayed. It is best practice to use the same password for
backup archives in the same folder within the archive location.

Encryption
After setting a password, you can choose to encrypt the backup with an industrystandard AES cryptographic algorithm for advanced security.
To set up backup encryption, select one of the following encryption types:
•

None – backups will not be encrypted

•

AES 128 – the quickest encryption method available (set by default)

•

AES 192 – encryption will take longer than 128-bit, but is more secure

•

AES 256 – requires the most amount of time to cipher, but it is also the
most secure setting available

5.3.5 Backup Type Substitution
A full backup of the database is required before creating differential or transaction log
backups. If for some reason a full backup does not exist, you will need to create a full
backup independently of the backup strategy you have configured.
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You can specify the behavior of Acronis Recovery for MS SQL Server when creating
differential backup or backing up transaction logs of databases with the Simple
recovery model:
•

Create a differential backup if transaction log backup creation is
impossible; Create a full backup if a differential backup creation
fails – will create a differential backup for a database with the Simple
recovery model (a transaction log backup can not be created for such
databases). A full backup will be created if the differential backup process
one fails.

•

If creation of the selected backup type fails, skip the backup
process – the backup process will be terminated if the selected backup
process fails.

Note, if you use the Acronis Recovery for MS SQL Server Assistant to define
the backup strategy, the Create differential backup if transaction log
backup creation is impossible. Create a full backup if a differential
backup creation fails option is selected by default.

5.3.6 Bandwidth Throttling
You can limit the bandwidth used by the backup process so that network resources will
be available for other processes.
To set the desired data transfer speed, check the Enable bandwidth throttling
parameter. Select a maximum bandwidth value from the drop-down list or enter a
value manually.
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5.3.7 Additional Settings
Validate backup archive once it has been created
When enabled, the program will verify the integrity of the archive immediately after it’s
created.
To validate archive data integrity you must have all of the backups in the
series (full, differential and transaction log backups) available in the same
location. If any of the successive backups are missing validation will not be
possible.
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Chapter 6. Disaster Recovery Plan

It is extremely important for all organizations and users to have detailed instructions
describing the process for recovering data quickly and efficiently in case of disaster – a
Disaster Recovery Plan. This plan should contain all of the required information to
guide someone through the recovery process. When creating a Disaster Recovery Plan,
be sure to include scenarios and procedures for different kinds of disaster situations
(loss of the database server, data corruption, complete loss of database etc).
The Disaster Recovery Plan should include step-by-step instructions for every possible
type of disaster, as well as the server’s hardware and software configuration.
With the Create Disaster Recovery Plan wizard, you can generate and view a
Disaster Recovery Plan for your database server immediately, or schedule to receive it
via e-mail after each update.

6.1 Viewing a Disaster Recovery Plan Immediately
Launch the Disaster Recovery Plan Creation wizard by clicking on the Disaster
Recovery Plan operation icon in the main workspace.
1. In the first step of the wizard, choose the View the Disaster Recovery
Plan for the selected database option to generate and view the Disaster
Recovery Plan for the selected databases immediately
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2. Select the databases you want to obtain the Disaster Recovery Plan for

3. Choose whether you want to receive the Disaster Recovery Plan by e-mail
or to view it in HTML format
4. If in the previous step you selected to receive the Disaster Recovery Plan by
e-mail, you will need to specify the e-mail parameters
Specify the e-mail account that will be used for sending the Disaster
Recovery Plan. Provide the e-mail address to which the plan will be sent
and the outgoing SMTP server name. You can specify several e-mail
addresses separating them by commas
A Username and a password may also be needed if the SMTP server
requires authentication.
You can check if the settings are correct by clicking the Send test E-Mail
message button
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5. The final stage of the Disaster Recovery Plan Creation wizard is the
summary window, which display the list of operations to be performed.
Click Finish to obtain the Disaster Recovery Plan immediately.
In the latter case an e-mail will be sent to the address you specified or a
HTML version of the Disaster Recovery Plan will be opened in your web
browser after you click Finish.

6.2 Scheduling Receipt of the Disaster Recovery Plan
Launch the Disaster Recovery Plan Creation wizard by clicking on the Disaster
Recovery Plan operation icon in the main workspace.
1. In the first step of the wizard, use the Define databases for which you
want to receive the plan each time it is updated option to choose
which databases to generate the Disaster Recovery Plan for each time any
changes occur. The updated version of the plan will automatically be sent to
e-mail addresses you specify.

2. Select the databases for which you want to obtain the Disaster Recovery
Plan.
3. Specify the e-mail account that will be used for sending the Disaster
Recovery Plan. Provide the e-mail address to which the plan will be sent
and the outgoing SMTP server name. You can specify several e-mail
addresses separating them with commas.
A Username and a password may also be needed if the SMTP server
requires authentication.
You can check if the settings are correct by clicking the Send test E-Mail
message button.
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4. The final stage of the Disaster Recovery Plan Creation wizard is the
summary window which displays the list of operations to be performed.
Click Finish to schedule receipt of the Disaster Recovery Plan after each
update.

6.3

Summary

Thus, in case of disaster, you only need to take the most recent version of the Disaster
Recovery Plan and follow the instructions to restore your databases.
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Chapter 7. Import a Maintenance Plan

With Acronis Recovery for MS SQL Server, you are able to import an existing Microsoft
SQL Server Maintenance Plan for a database and convert it into an Acronis Recovery
for MS SQL Server task. Later on, you can work with the imported task, as with the
regular Acronis backup task i.e.: launch the task, edit the tasks’ options and schedule
the task execution parameters.
Launch the Import Maintenance Plan wizard by clicking on the icon in the main
area.

7.1 Specifying a Task Execution Account
In the first step of the Import Maintenance Plans wizard, specify an account that is
valid on the computer where the databases you want to backup are located – a task
execution account. These credentials will be used during each task execution for
connecting to the server and, by default, for connecting to the Microsoft SQL Server (if
you do not specify another account for Microsoft SQL Server while selecting the source
to backup).
Thus, the task will run as it was started by the specified user.
Enter the Username and password, then click Next. The domain name must be
specified if the user is a member of a domain (DOMAIN\Username).
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7.2 Selecting a Maintenance Plan
Select the database maintenance plan you want to import from the tree in the left
pane. Information about the selected maintenance plan will be displayed in the right
pane. Select a job from the tree. The associated schedule and objects will be shown on
the right.
To disable a Microsoft SQL Server, task after importing the maintenance plan, select
the Disable SQL task after import checkbox. The Microsoft SQL Server maintenance
plan will be deleted after importing.
Click Next to continue.

7.3 Import Summary
In the final step, the import summary is displayed. Up to this point, you can click Back
to make changes in the created task. If you click Cancel, no maintenance plan will be
imported. Clicking Proceed will launch the task execution – importing the SQL
Maintenance Plan and converting it to an Acronis task.
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Chapter 8. Backup Location Clean-up

Sooner or later the backups you create will fill up the assigned storage space. Acronis
Recovery for MS SQL Server allows you to clean up backup locations by specifying how
long to store the archive and/or the maximum number of full backups to store. By
default, these options are disabled.
Launch the Backup Location Clean-up wizard by clicking on the icon in the main
program window.

8.1 Specifying a Task Execution Account
In the first step of the Backup Location Clean-up wizard, you have to specify a local
or domain account which is valid on the computer where the archives are stored – a
task execution account. The specified account must have rights and permissions to
manage files in the backup location you want to clean up.
Enter the Username and password then click Next. The domain name must be
specified if the user is a member of a domain (DOMAIN\Username).

8.2 Selecting the Backup Archive Location
Select the backup location you want to clean from the tree, or manually specify the
path to it in the Path field below the tree. You can also select Acronis backup locations
(such as Acronis Backup Server).
The following resources may also be selected for backup locations:
•

Entire disk or disk folder

•

Network share, SAN, NAS

•

FTP

•

Acronis Backup Server

Click Next to provide a password, if one is required, for archives in the selected
backup location.
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8.3 Providing a Password
If there are any password-protected backup archives in the location you have selected
(see 8.2), you will need to enter the password to clean up the archive location.

Click Next to continue.

8.4 Specifying Cleaning Options
Specify the maximum lifetime of an archive and the maximum number of full backups
to store.
Select the Consider maximum archive’s life check box and type or select a number
of days to store archives in the Days box.

62

Select the Consider maximum full backup check box and type or select the
maximum number of full backup archives to store.

8.5 Schedule Cleaning
Acronis Recovery for MS SQL Server allows you to schedule backup location clean-up.
Specify the schedule that would be the best for your needs (see Chapter 10.
“Scheduling Tasks” for detailed information).

8.6 Backup Location Clean-up Summary
The final stage of the backup location clean-up is the summary window, where the list
of operations which will be performed is displayed.
Click Finish to save the created schedule or start the backup location clean-up task
immediately.
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Chapter 9. Restoring the Backup Data

Launch the Restore Data wizard by clicking on the restore operation icon in the main
workspace.

9.1 Restore
9.1.1 Restoration Time Selection
In the first step of the Restore Data wizard you will select when to run the
restoration process. There are two choices:
•

Now – select this option to execute the restore operation immediately after
you finish the wizard

•

On schedule – select this option to schedule the operation

9.1.2 Specifying a Task Execution Account
In this step of the Restore Data wizard, specify an account that is valid on the
computer where the databases you want to restore are located– a task execution
account. These credentials will be used during each task execution for connecting to
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the server and, by default, for connecting to the Microsoft SQL Server (if you do not
specify another account for Microsoft SQL Server while selecting the source to backup).
Thus, the task will run as if it was started by the specified user.
Enter the Username and password then click Next. The domain name must be
specified if the user is a member of a domain (DOMAIN\Username).

9.1.3 Selecting a Database Backup Location
Select the appropriate backup location in the tree or specify the path to it manually in
the Path field below the tree. Acronis Recovery for MS SQL Server stores up to ten
locations for the last archives created in a special folder – Recent Backup Locations
- so you can easily locate the appropriate archive.
You can also select specific Acronis backup locations (such as Acronis Backup Server).
The following resources may also be selected as backup locations:
•

Entire disk or disk folder

•

Network share, SAN, NAS

•

FTP

•

Acronis Backup Server

•

Tapes, Autoloaders, Tape Libraries

The number of archives in the selected folder is displayed in the right pane.

Click Next to continue.

9.1.4 Selecting a Backup Task
If several backup tasks use the same location to store archives, you have to select the
task you want to restore from.
Click Next to continue.
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9.1.5 Providing a Password
If there are any password-protected backup archives in the location you have selected
(see 9.1.3), you will need to enter the password to restore your data from archives.
Click Next to continue.

9.1.6 Restore Point Selection
Specify to which state you want to restore your data.
Acronis Recovery for MS SQL Server offers four ways for restoring your data:
•

to the point of failure – the data will be restored to the state at the point
of failure. Note, this type of restoration is possible only for databases that
are using the full or bulk-logged recovery models (i.e. you need backed up
transaction logs). Acronis Recovery for MS SQL Server will restore
databases from Full, Differential and Transaction Logs backups (if any), and
then will apply Active Log if it exists and was not corrupted during the
failure. Keep in mind, that restoring to the point of failure can take a long
time.

•

to the time of the latest backup – choosing this option will restore your
data to the state when the last backup was created. Acronis Recovery for
MS SQL Server will restore databases from Full, Differential and Transaction
Logs backups (if any), but will not apply Active Log. So restoration to the
latest backup will be faster, than restoration to the point of failure.

•

to the specific point in time - Acronis Recovery for MS SQL Server
Acronis Recovery for MS SQL Server allows you to specify a date and time
to restore your data from. As with restoring to the point of failure, Acronis
Recovery for MS SQL Server will restore databases from full, differential and
transaction log backups (if any), and then will apply the active log if it exists
and was not corrupted during the failure. If the active log is applied this
operation will take longer to execute.

•

from the selected backup – select this option to choose a backup from
which to restore. A list of backups will be available by clicking on the Select
from the list of backups link. Choose the backup you want to restore
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from and click OK. As with restoring to the time of the latest backup,
Acronis Recovery for MS SQL Server will restore databases from Full,
Differential and Transaction Logs backups (if any), but will not apply Active
Log.

After selecting the appropriate option click Next to continue.

9.1.7 Content Selection
Acronis Recovery for MS SQL Server allows restoring instances, single databases and
filegroups. Select a database server from the tree in the left pane.

Restoring Instances
Choose an instance to restore. Information about this instance will be displayed on the
right.
To change the type of authentication (Windows or Microsoft SQL Server), click
Change. See 5.3.5 for detailed information.
In the drop-down list, specify the instance you want to restore from.
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Restoring Databases
Choose the database to restore. You can set all the recovery parameters as described
above in the Restoring instances section. Additionally, you may customize the
location, where database files will be restored, and setting the database state after
restoring.
Note, you can restore a database from rolling snapshots. Remove the
database snapshots using Microsoft SQL Server Management Studio then
begin the restore operation.
Select Use the customizable file paths to restore the database to a new location.
Click Customize file path… to change settings. Default paths are displayed in the
respective fields.
If you define a file name (including the full path) that already exists, old files will be
overwritten. If you do not define the full path, the files will be added to the default
data directory of the current instance.
Note, existing paths for data and log files will be used as default.
Also, Acronis Recovery for MS SQL Server allows you to specify paths for separate files.
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Click OK to continue.

Restoring System Databases
System databases can only be restored from a backup created in the Microsoft SQL
Server version that the server instance is currently running.
The master database must be accessible to run a Microsoft SQL Server instance and to
restore databases.
If the master database is not accessible, you have to restore the database from a full
backup and rebuild it.
It is necessary to restore the model and msdb databases if:
•

the master database must be rebuilt

•

the model and msdb databases are corrupted

•

the model database was modified (it has been deleted and re-created after
rebuilding the master database)

Selecting Filegroups to Restore
By default, filegroups of the selected database will be selected for restore. If you do
not want to restore specific filegroups, uncheck them in the tree in the left pane. Also
if all filegroups are selected, the entire database will be restored.
Please, keep in mind, restoring separate filegroups over an existing database
is possible only if you selected restoring to the point of failure. Other types
of filegroups restoration are valid only for newly created databases
(automatically created during the restoration process).
To view the information about filegroups in the right pane, select them from the tree.
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If the filegroup restore completes with an error message about the database
checksum validation failure (824), the database is not consistent after
restoring. You should restore the entire database.
After defining all the required parameters click Next to continue.

9.1.8 Restore Options
Select the options for the restoration process (Pre/Post commands, restoration process
priority etc.). You can Use default options (See 9.2 “Setting Default Restore
Options” for more information.) or Set the options manually. If the latter is the
case, the settings will be applied only to the current restore task.

9.1.9 Selecting Start Parameters
You can run a restore task manually or specify the frequency (Daily, Weekly or
Monthly). See Chapter 10 “Scheduling Tasks” for detailed information.
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9.1.10

Restore Summary

In the final step, the restoration summary is displayed. Up to this point, you can click
Back to make changes in the created task. If you click Cancel, no databases will be
restored.

Click Finish to save the schedule or start the restore task immediately.

9.2 Setting Default Restore Options
To view or edit the default restore options, select Tools -> Options -> Default
Restoration Options from the main program menu.
You can also edit restore options while creating a restore task.
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9.2.1 Pre/Post Commands
You can specify commands or batch files to be automatically executed before and after
the restore procedure. Click Edit to open the Edit Command window and input the
command, its arguments and the working directory, or browse folders to find a batch
file. Interactive commands (commands that require user input) are not supported).

9.2.2 Restoration Priority
You can set up the restore process priority:
•

Low - the restore process will run slower, but it will not influence other
processes running on your computer

•

Normal - set by default. The restore process will run with normal priority

•

High - the restore process will run faster, but it may influence other
processes running on your computer

Changing the restore process priority may have an adverse effect on the performance
of other programs running simultaneously. The priority of any process running in the
system determines the amount of CPU usage and system resources allocated to that
process.

73

9.2.3 Additional Settings
Backup archive validation
Before data is restored from the archive, Acronis Recovery for MS SQL Server can
check its integrity. If you suspect that the archive might have been corrupted, select
Validate backup archive before restoration.

Databases overwriting mode
This option allows you to keep useful data changes made since the restored backup
was completed. If you are to rename a database or change the default instance, the
restored database can overwrite the existing one. So, you can select the Overwrite
existing databases option to give the archived database unconditional priority over
the database on the hard disk.
By default this option is selected.

Disconnecting before restoration
Selecting the Disconnect from database before restoration option allows you to
minimize the number of active connections to the server before executing the restore
operation.
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Chapter 10.

Scheduling Tasks

10.1 What is a task?
A task is a job you execute for a database that includes the type of operation (backup,
restore, etc.), parameters of the operation (what to backup, what to restore, etc.) and
a schedule (optional). Each time you want to perform an operation with specific
parameters, you should create a task. Once the task is created, you can execute it
manually at any time or run it on a scheduled basis (if provided). You can also
schedule independent or redundant tasks for the same database or instances.

10.2 Setting Schedule Parameters
You can run a task manually or specify the frequency (Daily, Weekly or Monthly).
Manually – this option allows you to create a task without specifying the exact
schedule of its execution. The created task appears in the task management list and
may be run at any time.
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Daily - the task will be executed daily at the specified time. You can set the following
parameters:
Parameter

Description

Recur every (…) The task execution frequency
days
Start time

Time for starting the task. The current time is set by default

Repeat

Task execution frequency: Once for a single execution and
Every (…) for periodic executions throughout the day (in
minutes or hours)

End time

Time when the schedule will be disabled

Start date

Select this check box to specify the date to enable this schedule

End date

Select this check box to specify the date when this schedule will
be disabled

Weekly - the task will be executed on a weekly basis at the specified time and days.
You can set the following parameters:
Parameter
Recur
weeks

every

Description
(…) The task execution frequency. Select individual days of the
week, all days or only workdays.

Start time

Time for starting the task. The current time is set by default

Repeat

Task execution frequency: Once for a single execution and
Every (…) for periodic executions during the day (in hours)

End time

Time when the schedule will be disabled

Start date

Select this check box to specify the date to enable this schedule
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End date

Select this check box to specify the date when this schedule will
be disabled

Monthly - the task will be executed monthly at the specified time and day. You can
set the following parameters:
Parameter

Description

Months

Select months for the task execution from the drop-down list.
Then choose one of the following parameters:
Days - choose this parameter to specify days of the selected
months for task execution. Choose the dates from the dropdown list. Also you can select Last (to execute the task on the
last day of the chosen months) or All days. For example, if you
have selected “15” and “Last”, the task will be executed on
every 15th and every last day of the selected months.
On - choose this parameter to select a week number of the
month (also Last or All) and the day of the week (as well as
All days and All Workdays) for task execution. For example,
if you have selected “First” and “Monday”, the task will be
executed on the first Monday of the selected months.

Start time

Time for starting the task. The current time is set by default

Repeat

Task execution frequency: Once for a single execution and
Every (…) for periodic executions during the day (in hours)

End time

Time when this schedule will be disabled

Start date

Select this check box to specify the date to enable this schedule

End date

Select this check box to specify the date when this schedule will
be disabled

78

One time - the task will be executed once at the specified time and day. You can set
the Start time parameter: specify the date and time to start the operation. Current
time is set by default.

All the settings you made are displayed in the Result field at the bottom of the
window.
To save your settings, click OK.
To quit task scheduling without saving, click Cancel.
Note, Acronis Recovery for MS SQL Server allows you to set multiple schedules for one
task. For example, you can backup your data not only once a week, but also on the
last day of each month. You can specify Weekly and Monthly parameters to have the
necessary operation schedule.
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Chapter 11.

Managing Tasks

To manage operations, click Manage Tasks in the Pick a Tool group or select the
Tools -> Manage tasks menu item.
All the scheduled tasks appear in the Scheduled Tasks pane in the Manage Computer
Tasks window of the Acronis Recovery for MS SQL Server Management Console.
Information about the task name, credentials, the type of backup, its status
(completed, scheduled), the task’s schedule and the date and time when it was run
last is displayed.
You can edit, start, and delete the scheduled tasks from these windows, as well as edit
the scheduled set of tasks.
Note, backup tasks may consist of three subtasks: full, differential and
transaction log backups. You can manage these subtasks separately.
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11.1 Editing a Task
To edit a task, select it in the Tasks window and click Edit Task on the left. Follow the
wizard’s instructions on the screen.

11.2 Deleting a Task
To delete an existing task, select it in the Tasks window and click Delete Task on the
left. Follow the wizard’s instructions on the screen.

11.3 Starting a Task
To begin executing an existing task immediately, select it in the Tasks window and
click Start Task Now on the left.

11.4 Viewing a Disaster Recovery Plan
Click the View Disaster Recovery Plan link in the tasks pane. The plan is provided
in HTML format. See details in Chapter 6 “Disaster Recovery Plan”.
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Chapter 12.

Notifications

Acronis Recovery for MS SQL Server can notify you when a task is complete using an
SNMP service or via e-mail.
By default all notifications are disabled.

12.1 E-mail Notifications
Specify the default e-mail account that will be used for notifications regarding the
backup operation process. Provide the e-mail address to which notifications will be sent
and the outgoing SMTP server name. A Username and a password may also be needed
if the SMTP server requires authentication.
You can choose when you want to receive notifications:
•

after successful completion of the operation

•

if the operation fails

Click the Additional e-mail parameters… link to specify the From and Subject
fields for the notification e-mail.
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You can check if the settings are correct by clicking the Send Test E-mail Message
button.

12.2 SNMP
You can choose whether to send event log messages issued by Acronis Recovery for
MS SQL Server to computers running SNMP (Simple Network Management Protocol)
management applications.
To specify SNMP settings, check the Send Notification with SNMP parameter to enable
SNMP notification.
In the Community Name field, enter the name of the SNMP community to which
both the Host (the computer running the SNMP management application) and the
computer running the task belong.
In the Host Name field, enter a name of the computer running the SNMP
management application, to which notifications will be sent. If not specified, messages
will be sent to all SNMP clients found in the local network.
Below in this window you can choose whether you want to get notifications:
•

upon the operation's successful completion parameter

•

upon the operation failure parameter

You can check if the settings are correct by clicking the Send test SNMP message
button.

12.3 Windows event log
You can save event messages to the Windows Event Log (to see this log, run
eventvwr.exe or select Control Panel -> Administrative tools -> Event Viewer).
To save event messages to Windows Event Log select the Save messages option and
choose one of the following from the drop-down list:
•

All events - all events (information, warnings and error messages) will be
recorded to the Windows Event Log
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•

Warnings and errors - warnings and error messages will be recorded to
the Windows Event Log

•

Errors only - only error messages will be recorded to the Windows Event
Log
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Chapter 13.

Viewing Logs

Users can view the Acronis Recovery for MS SQL Server working logs. The logs provide
information about scheduled task results, including failure reasons, if any. To view
logs, click the Logs item in the Pick a Tool group.
The log browsing window contains two panels: the left panel features the log list, and
the right panel displays the selected log’s contents. You can set up list parameters to
only display messages of a particular type, display particular columns, or select a
sorting order.
To the left, there are 3 message filter options:
•

filter error messages

•

filter warnings

•

filter information messages

To select columns to display, click the button and check columns to display.
To sort messages by a particular column, click its header (click again to reverse the
order) or the button (the second from the right) and select the desired column.
You can also change column width by dragging its borders with the mouse.
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Appendix A. Acronis Recovery for MS
SQL Server: Best Practices
This section provides instructions for best practices when using Acronis Recovery for
MS SQL Server.

A.1 Protect your server from hardware failure, user errors
and viruses
Scenario
The company is running several internet and intranet applications on several Windows
2000 servers using Microsoft SQL Server as the back end (using different instances).
Since all transactions are stored in the database, any data loss is not acceptable. The
database administrator must provide protection from hardware failure, user errors and
virus attacks.

Acronis solution
Use the following components


Acronis Recovery for MS SQL Server Agent (on all servers with databases)



Acronis Recovery for MS SQL Server Management Console (on an administrator
workstation, from which you plan to manage tasks)

To schedule periodic backup
1. Install Acronis Recovery for MS SQL Server Management Console on the
database administrator workstation and Acronis Recovery for MS SQL Server
Agents on the server where Microsoft SQL Server instances are located
For every Microsoft SQL Server instance perform the following actions:
2. Connect to the server from the Acronis Recovery for MS SQL Server
Management Console using the appropriate credentials
3. Launch the Create Backup wizard and follow the instructions to create a
backup task:
a. Select the whole Microsoft SQL Server instance (or all available
instances) as a backup source
b. Select a backup destination
c. Select Full, Differential and Transaction logs backups type
d. Schedule full backups for every month, differential backups for every
week and transaction log backup for every day
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e. Use default settings for backup
f. Add the necessary comments for the task
g. Save the created task

To recover all data in case of hardware failure
For every damaged server perform the following actions:
1. Install and configure a new server. Install the necessary Microsoft SQL Server
instances on the server.
2. Install Acronis Recovery for MS SQL Server Agent on the server
3. Connect to the server from Acronis Recovery for MS SQL Server Management
Console using the appropriate credentials
4. Launch the Restore Data wizard and follow the instructions to restore the
database:
a. Select the backup archive location
b. Select the Restore to point of failure option
c. Select the whole Microsoft SQL Server instance (or several instances) to
restore from, then specify the target instance for each instance.
d. Start the restore operation
All Microsoft SQL Server instances will be restored to the point of failure to
avoid data loss.

To recover all data in case of a user mistake
For all servers perform the following actions:
1. Connect to the server from Acronis Recovery for MS SQL Server Management
Console using the appropriate credentials
2. Launch the Restore Data wizard and follow instructions to restore the
database:
a. Select the backup archive location
b. Select the Restore to point in time option and specify the date and
time manually, or select the backup from the list of backups.
c. Select the database to restore from the archive
d. Start the restore operation
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Only one database will be restored to the selected point in time.

To recover all data in case of a virus attack
For all servers perform the following actions:
1. Recover the server from viruses, reinstall the operating system or replace the
server with a new one.
2. Connect to the server from Acronis Recovery for MS SQL Server Management
Console using the appropriate credentials
3. Launch the Restore Data wizard and follow the instructions to restore the
database:
a. Select a backup archive location
b. Select the Restore to point in time option and specify the date and
time manually or select the required backup from the list of backups.
c. Select the whole Microsoft SQL Server instance (or several instances) to
restore, and specify the target instance for each instance.
d. Start the restore operation
All Microsoft SQL Server instances will be restored to the point in time.

A.2 Protect your server to guarantee minimal data loss
Scenario
The database administrator must organize the server backup creation so that in case of
a server failure for any reason, the maximum data loss would not be more than 15
minutes.

Acronis solution
Connect to Acronis Recovery for MS SQL Server Management Console and create a
backup task for Microsoft SQL Server with the following backup strategy: Full Backup
(every week) + Differential backup (every day) + Transaction log backup (every 15
minutes).
To recover all data in case of failure, use the same procedure as described in the
previous scenario (A.1).

A.3 Migrate to another Microsoft SQL Server version.
Scenario
The company needs to move a database to another server, where a newer Microsoft
SQL Server version is installed. After the migration, the server must have a different
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name, and the old server must remain operational (to provide fast database rollback in
case a contingency occurs).

Acronis solution
1. Install a new Microsoft SQL Server instance.
2. Set the old database to StandBy mode.
3. Create a backup of the old Microsoft SQL Server instance using a previously
created task (running it from the Acronis Recovery for MS SQL Server
Management Console) or create a new task (full backup).
4. Restore to a new Microsoft SQL Server instance.
5. Specify new settings for working with a new Microsoft SQL Server instance.

A.4 Backing up several databases
Scenario
The company uses only one Microsoft SQL Server instance for running several
databases. All databases have different levels of importance concerning data loss:
some of them need to be backed up every day, others require only weekly backups.

Acronis solution
The database administrator should create independent tasks for different databases.
While creating a task, the database administrator specifies the appropriate schedule for
each database.

A.5 Encrypting database archives for storage
Scenario
The company stores database backup archives off-site, hence they should be
effectively protected (encrypted).

Acronis solution
While creating a backup task, the database administrator should set a password to
protect the archive and encryption type (AES 128, 192 or 256) by specifying backup
options.
While creating the restore task, the administrator has to provide the correct password
to the archive in order to restore the data. The password should be kept in a safe
place so that data may be restored if the company hires new administrators.

A.6 Using the Disaster Recovery Plan to restore databases
Scenario
The business owner wants to be sure that the databases can be restored at any time,
even in case the database administrator is not available for any reason. For that
purpose, a comprehensive Disaster Recovery Plan should be created, which will help a
person without DBA knowledge restore damaged databases.
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Acronis solution
While creating a backup task, the database administrator should specify a Disaster
Recovery Plan option, so that it would be sent to the business owner’s email. In case
of a disaster, the staff can restore databases according to the instructions contained in
the Disaster Recovery Plan.

A.7 Restore databases immediately using rolling snapshots
(for Microsoft SQL Server 2005 Enterprise only)
Scenario
Database administrator must be able to restore databases in the shortest amount of
time.

Acronis solution
While creating a backup task, the database administrator should specify the option
Create rolling snapshots immediately after differential backup is created and
set the required number of snapshots to store.
To restore from a rolling snapshot the database administrator should use
Microsoft SQL Server tools.

A.8 Manual backup (before crucial changes in databases)
Scenario
The company is preparing to make extensive changes to the databases. To avoid
possible loss, the databases must be backed up.

Acronis solution
The database administrator can use previously created backup tasks and start them
manually from the Acronis Recovery for MS SQL Server Management Console.
Another option is to start a new task for creating full backups. The administrator can
specify it so that it will only be executed manually.
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Appendix B. Installing Acronis
Recovery for MS SQL Server from
command line

Acronis Recovery for MS SQL Server supports the Microsoft Installer utility
(msiexec.exe) with all its commands. Here is the MSI installation command and
options:

Install Options
/i <Component.msi | ProductCode>
Installs or configures a product. ProductCode is the serial number of your
personal copy of Acronis Recovery for MS SQL Server Agent
COMPONENT=[component]
Specifies the component you want to install:
Agent_MSSQL - Acronis Recovery for MS SQL Server Agent
Tools_MSSQL - Acronis Recovery for MS SQL Server Management Tools
USERNAME=[username] PASSWORD=[password]
Specifies username and password for running Acronis Recovery for MS SQL
Server Agent installation
/e[path]
Specifies a path to extract an .msi file to.
/a <Component.msi | ProductCode>
Applies the administrative installation option
/x <Component.msi | ProductCode>
Uninstalls the product
Example
msiexec /i C:\Agent_MSSQL.msi
Installs Acronis Recovery for MS SQL Server Agent.
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Reinstall Options
/f[p|o|e|d|c|a|u|m|s|v] <Component.msi | ProductCode>

Reinstalls or upgrades the product
p – reinstalls only missing files
o – reinstalls the file if it is missing or it is an older version
e - reinstalls the file if it is missing or is the same or an older version
d - reinstalls the file if it is missing or a different version is present
c – verifies the checksum values, and reinstalls the file if it is missing or corrupt
a – reinstalls all files
u – rewrites all required registry entries from the Registry Table that go to the

HKEY_CURRENT_USER or HKEY_USERS registry hive
m – rewrites all required registry entries from the Registry Table that go to the

HKEY_LOCAL_MACHINE or HKEY_CLASSES_ROOT registry hive
s – reinstalls all shortcuts and re-caches all icons overwriting any existing
shortcuts and icons
v - used to run from the source package and re-cache the local package.
This option ignores any property values you specify at the command line. The
default value for this option is /fpecms.
Example
msiexec /fpecms C:\Agent_MSSQL.msi
Reinstalls Acronis Recovery for MS SQL Server Agent.

Advertising Options
/j[u|m]
Advertises a component with the following options:
u – only for the current user
m – for all users of the computer
/g LanguageID – identifies the language
/t TransformList – applies transform to advertised component
This option ignores any property values you specify at the command line. To install the
component with elevated privileges, use /jm.
Example
msiexec /jm C:\Agent_MSSQL.msi
Advertises Acronis Recovery for MS SQL Server Agent for all users of the computer.

Logging Level Options
msiexec /L [i][w][e][a][r][u][c][m][p][v][+][!]LogFile.txt
/L - Specifies the path to the log file
i - Logs status messages
92

w - Logs nonfatal warnings
e - Logs all error messages
a - Logs startup of actions
r - Logs action-specific records
u - Logs user requests
c - Logs initial user interface parameters
m - Logs out-of-memory
p - Logs terminal properties
v - Logs verbose output. To use v, specify /L*v
+ - Appends to existing file
! - Flushes each line to the log
* - Logs all information except for the v option. This is a wildcard

LogFile.txt - Name and path of the text log file
To include the v option into a log file using the wildcard flag, specify /L*v at the
command line.
Example
msiexec /i C:\Agent_MSSQL.msi /Lime logs.txt
Installs Acronis Recovery for MS SQL Server Agent and creates log file logs.txt
containing information about the status, out-of-memory and error messages.

Applying a Patch Options
/p PatchPackage
/p - Applies a patch

PatchPackage - Specific patch
Example
msiexec /p PatchPackage /a C:\Agent_MSSQL.msi
Applies a patch to an administrative installation component.

Options for Installing a Transform
msiexec /i component TRANSFORMS=TransformList
TRANSFORMS= - Property that is used to specify what transform (.mst) files
should be applied to the component

TransformList - List of paths separated by semicolons
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Options for Advertising Using a Transform
msiexec /j[u][m] component /t TransformList
User Interface Level Options
msiexec /q{n|b|r|f|n+|b+|b-}
/qn - Displays no user interface
/qb - Displays a basic user interface
/qr - Displays a reduced user interface with a modal dialog box displayed at
the end of the installation
/qf - Displays the full user interface with a modal dialog box displayed at the
end
/qn+ - Displays no user interface, except for a modal dialog box displayed at
the end
/qb+ - Displays a basic user interface with a modal dialog box displayed at the
end
/qb- - Displays a basic user interface with no modal dialog boxes
Note, /qb+- is not a supported user interface level. The modal box is not displayed if
the user cancels the installation.
Example
msiexec /qb Agent_MSSQL.msi
Displays the basic user interface options during the Acronis Recovery for MS SQL
Server Agent installation.

Copyright Information Displaying Options
msiexec {/?|/h}
Displays the Windows Installer version and copyright information.

Calling the system API DllRegisterServer Option
msiexec /y|z module
/y - Calls the system API DllRegisterServer to self-register modules passed on
the command line
/z - Calls the system API DllUnRegisterServer to unregister modules passed on
the command line

module - Specifies the file name of the module
These options are only used for registry information that cannot be added using the
registry tables of the .msi file.
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